
Chapter 14

Working with 
Sheetmetal 

Components
  Learning Objectives  
After completing this chapter, you will be able to:
•  Create unattached flat walls
•  Create reliefs in the sheetmetal component
•  Create a flat wall
•  Create the twist and extend walls
•  Add flange walls to sheetmetal components
•  Bend a sheetmetal component
•  Unbend and bend back the sheetmetal component
•  Convert solid models to sheetmetal components
•  Create a flat pattern of the sheetmetal component
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INTRODUCTION TO SHEETMETAL
A sheetmetal component is created by bending, cutting, or deforming a thin sheet of uniform 
thickness. The sheetmetal designs are created in the Sheetmetal mode of Creo Parametric. The 
Sheetmetal mode provides you the options to create primary and secondary walls and convert 
a solid model into a sheetmetal component. 

INVOKING THE SHEETMETAL MODE
To invoke the Sheetmetal mode, choose the New button from the Quick Access toolbar; the 
New dialog box will be displayed. In this dialog box, the Part radio button in the Type area 
and the Solid radio button in the Sub-type area are selected by default. Select the Sheetmetal 
radio button from the Sub-type area, as shown in Figure 14-1. Enter the name of the file in the 
File name edit box and choose the OK button from the New dialog box; the Sheetmetal mode 
will be invoked.

Figure 14-1  The New dialog box

The initial screen appearance in the Sheetmetal mode is shown in Figure 14-2. The initial 
screen appearance in the Sheetmetal mode is similar to the initial screen appearance in the 
Part mode. The three default datum planes, FRONT, TOP, and RIGHT will be displayed in 
the drawing area. These datum planes are mutually perpendicular to each other. The Model 
Tree will be displayed at the left of the drawing area. 

The process of creating sheetmetal components is similar to that of creating solid or surface 
protrusions. You first need to create the sketch of the base feature and then use various tools 
such as Flat, Flange, and so on to create sheetmetal components.
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Figure 14-2  The initial screen appearance in the Sheetmetal mode 

INTRODUCTION TO SHEETMETAL WALLS  
A wall is defined as any planar section in a sheetmetal design. There are two types of walls in 
Sheetmetal mode of Creo Parametric. They are discussed next.

Primary Walls
Primary walls are created as base features and are independent entities. The different type of 
primary walls are unattached flat wall, unattached extruded wall, revolved wall, blended wall, 
offset wall, and so on.

Secondary Walls
Secondary walls are the walls that are dependent on at least one primary wall. They share a 
parent-child relation with the primary walls. Secondary walls include all the primary walls and 
also walls such as flat wall, flange wall, extend wall, twist wall, and so on.

To design a part from scratch, you need to create the primary wall as the base feature. The 
other features such as flange wall, extend wall, and so on can then be created with reference to 
the primary walls.

Creating the Planar Wall
  Ribbon:  Sheetmetal > Walls > Planar     

The first feature created in a sheetmetal design is the base feature. This base feature is 
known as the unattached flat wall. To create a planar wall, choose the Planar tool from 

the Walls group of the Ribbon; the Planar dashboard will be displayed, as shown in 
Figure 14-3. Options in this dashboard are discussed next.
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Figure 14-3  Partial view of the Planar dashboard

References Tab
When you choose the References tab, a slide-down panel will be displayed, as shown in 
Figure 14-4. This slide-down panel helps you to select the sketching plane to create the sketch. 
Choose the Define button to display the Sketch dialog box. Select the required sketching plane 
and orient it. Once you enter the sketcher environment, you need to create the sketch for the 
wall and then choose the OK button to exit the sketcher environment. Next, enter the thickness 
of the sheet in the edit box in the Planar dashboard. Finally, choose the OK button to complete 
the creation of the unattached flat wall. Figure 14-5 shows a sheetmetal model created using 
this method.

Figure 14-4  The References 
slide-down panel   

Figure 14-5  Model of the unattached flat wall 

Properties Tab
When you choose the Properties tab, a slide-down panel will be displayed. This slide-down 
panel displays the feature identity in the Name collector. The i button in the slide-down panel, 
when chosen, opens the browser that displays all information about the feature you are creating. 

Note
The Options tab will not be enabled when you are creating the unattached planar wall or any 
other primary wall. It will be enabled only when the secondary walls are being created.

Creating the Unattached Revolve Wall
  Ribbon:  Sheetmetal > Walls > Revolve     

The unattached revolve wall is a feature created by revolving a sketched section about a 
centerline. The revolve wall can be a primary or secondary wall. When you choose the 

Revolve tool from the expanded Walls group, the Revolve dashboard will be displayed, as shown 
in Figures 14-6.
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Tip
1. You can move tools from the expanded Walls group to the Ribbon by right-clicking on the 
desired tool and then choosing the Move to Group option from the shortcut menu.

2. You can also move tools from the Walls group to the expanded Shapes group by right-clicking 
on the desired tool and then choosing the Move to Overflow option from the shortcut menu.

Figure 14-6  Partial view of the Revolve dashboard

The method of creating a revolve wall is same as of

Figure 14-7  The Options slide-down panel

creating a revolve feature, refer to Chapter 4. The 
section for creating the revolve wall can be closed or 
open. When you choose the Options tab in the 
dashboard, a slide-down panel will be displayed, as 
shown in Figure 14-7. Some of the options in this tab 
are the same as for the Revolve feature. The 
sheetmetal options available in this slide-down panel 
are discussed next. 

Add bends on sharp edges
The Add bends on sharp edges check box is used 
to add rounds on the sharp edges. On selecting 
this check box, the Radius drop-down list gets 
activated. Using the left drop-down list, you can 
specify the radius value of rounds, and using the right 
drop-down list, you can specify the location of rounds.

Set driving surface opposite sketch 
plane
The Set driving surface opposite sketch plane check box is used to flip the driving surface. 
This option will be available only when you select the Do not merge to model radio button.
 
Keep merged edges
The Keep merged edges check box is used to merge the revolve surface with the existing walls. 
This option will be available when you select the Merge to model radio button. If you want to 
keep the edges merged with the existing wall, then you need to select the Keep merged edges 
check box. 

Figure 14-8 shows a closed sketch for creating the revolve wall and Figure 14-9 shows the resulting 
unattached revolved wall.



14-6						        Creo Parametric 7.0 for Designers

Figure 14-8  Closed sketch for creating the 
revolved wall    

Figure 14-9  Resulting unattached 
revolved wall 

Creating the Unattached Blend Wall 
  Ribbon:  Sheetmetal > Walls > Blend     

The Blend option connects two or more sections by combining the characteristics of each 
section. The number of entities in each section of the unattached blend wall should be the 

same. For example, you cannot blend a circle with a rectangle. This is because a rectangle is 
made up of four entities, whereas a circle is made up of only one entity. Therefore, these two 
sections can be blended only if the circle is divided into four entities.

The Blend option is used where the component to be created has varying cross-sections. To 
invoke this option, choose the Blend tool from the expanded Walls group; the Blend dashboard 
is displayed, as shown in Figure 14-10. The options in this dashboard are discussed next.

Figure 14-10  Partial view of the Blend dashboard

Blend with sketched sections
This button is used to create sketches in the drawing area to create the blend. The options 
for inserting sketches are available in the Sections tab that is discussed later in this chapter.

 
Blend with selected sections

This button is used to select sketches available in the drawing area to form the blend. The 
options for inserting sketches are available in the Sections tab.

Sections Tab
When you choose the Sections tab from the dashboard, the Sections slide-down panel will be 
displayed, as shown in Figure 14-11. This panel has two radio buttons that are discussed next.
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Figure 14-11  The Sections slide-down panel

Sketched sections
This radio button is used to create sketches in the drawing area to form the blend. When 
you select this radio button, the Define button will be displayed which is used to enter the 
sketcher environment. You can use the Insert button displayed in the panel to add more 
sketches in blend.

Selected sections
This radio button is used to select sketches from the drawing area to form the blend. 
You can use the Insert button displayed in the panel to add more sketches in blend.

Options Tab
The Options tab contains the options related to the shape to be created of the blend feature. 
The options available in this tab are discussed next.

Straight
The Straight radio button is available in the Blended surfaces area. This option is used to 
connect the vertices of all sections in a blend feature with straight lines. 

Smooth
The Smooth radio button is available in the Blended surfaces area. This option is used to 
connect the vertices of all sections in a blend feature with smooth curves. 

Capped Ends
The Capped Ends check box is available in the Start and End Sections area. 

Add bends on sharp edges
The Add bends on sharp edges check box is available in the Sheetmetal options area. This 
option is used to provide rounds on the sharp edges of a wall. On selecting this option, you 
can specify the value of radius in the edit box activated below this option.
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Tangency Tab
The Tangency tab will only be available when you select the Smooth radio button from the 
Options tab. The options in this tab are used to set the boundary of selected or created sketches 
in the Free, Tangent, or Normal condition.

Figure 14-12 shows the sketch of three sections that will be used to create the blend feature. 
Figures 14-13 and 14-14 show the parallel blend features with straight edges and smooth edges, 
respectively. These features are created using the sections shown in Figure 14-12.

Figure 14-12  The sketch showing three 
sections for creating the parallel blend feature 

Figure 14-13  Blend feature with 
straight edges 

Figure 14-14  Blend feature with 
smooth edges

Note
While drawing sections for creating an unattached blend wall, the start point of all sections should 
be in the same direction in order to avoid twisted blend features.

Creating the Unattached Rotational Blend Wall
 Ribbon:  Sheetmetal > Walls > Rotational Blend    

The rotational blends are created by using the sections that are rotated about the Y-axis 
up to a maximum of 120-degree. To do so, an angle called rotational blend angle has to 

be defined between each section. Each section in the rotational blend feature is rotated about a 
geometric centerline drawn in the first sketch. 

To invoke the Rotational Blend tool, choose Rotational Blend from the expanded Shapes group; 
the Rotational Blend dashboard will be displayed, as shown in Figure 14-15.  
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Figure 14-15  Partial view of the Rotational Blend dashboard

Figure 14-16 shows the sections used to create the rotational blend feature. As evident, in 
Figure 14-16, two sections are used to create the rotational blend feature and these sections are 
at an angle of 110-degree to each other. It is also evident from the figure that the second section 
is dimensioned from the geometric centerline that was defined in the first section. Figure 14-17 
shows the shaded model of the rotational blend feature.

Figure 14-16  Two dimensioned sections creating 
rotational blend feature  

Figure 14-17  Shaded model of the 
rotational blend feature

Note
You can select the Connect end and start sections check box from the Options tab to create a 
closed blend feature. But for creating a closed blend feature, there should be at least three sections.

Creating the Unattached Offset Wall
  Ribbon:  Sheetmetal > Editing > Offset     

The unattached offset wall is a reflection of a quilt or a surface set at a specified distance 
from the original wall. To create an offset wall, choose the Offset tool from the Editing 

group; the Offset dashboard will be displayed, as shown in Figure 14-18, and you will be prompted 
to select a quilt or a solid surface to offset. 

Figure 14-18  The Offset dashboard

Select the surface that you want to offset and enter the required distance value in the edit box 
available in the dashboard. You can also define the type of offset wall using the options in the 
Options tab. When you click on the Normal to Surface option from this slide-down panel, a 
drop-down list will be displayed, as shown in Figure 14-19. The options in the list are discussed 
next.
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Normal to Surface
The Normal to Surface option is selected by default. As a result, the offset wall is created normal 
to the quilt or selected surface. 

Controlled Fit
This option, when selected, creates the offset wall at a controlled distance.

Automatic Fit
This option automatically fits the offset wall at a distance from the quilt or surface. Figure 14-20 
shows the offset wall created at a distance of 30mm from the top surface of the original flat wall.

Figure 14-19  Expanded drop-down list displayed 
on choosing the Normal to Surface option

Figure 14-20  Model with the 
original wall and the offset wall

Note
An offset wall cannot be the first feature in your design.

Creating a Flat Wall
  Ribbon:  Sheetmetal > Walls > Flat     

A flat wall is a planar or an unbent section of the sheetmetal. To create a flat wall, first 
you need to create the primary wall. The creation of the primary wall (unattached flat 
wall) has been discussed earlier in this chapter. The flat wall can take any shape, but the 

surface adjacent to the attached edge must be planar. To create a flat wall, choose the Flat tool 
from the Walls group in the Sheetmetal tab; the Flat dashboard will be displayed, as shown in 
Figure 14-21. The options in this dashboard are discussed next.

Figure 14-21  Partial view of the Flat dashboard
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Placement Tab
When you choose the Placement tab, a slide-down panel will be displayed, as shown in 
Figure 14-22. The collector in this slide-down panel displays Select 1 item because the attachment 
edge has not yet been defined. When you select the attachment edge, the collector in the 
slide-down panel will display the edge selected. Also, a preview of the rectangular flat wall will 
be created perpendicular to the edge selected.

Shape Tab
When you choose the Shape tab and click on Section Preview, a slide-down panel will be 
displayed, as shown in Figure 14-23. This panel displays the predefined wall profiles and their 
default dimensions.

By default, Rectangle is selected in the Profiles drop-down list in the Flat dashboard Setting 
area. The different profiles of walls are Rectangle, Trapezoid, L, T, and User Defined. These 
profiles can be selected from the Profiles drop-down list in the Flat dashboard.

Figure 14-22  The Placement slide-down 
panel

Figure 14-23  The Shape 
slide-down panel

Bend Position Tab					  
The options in this tab are used to create a flat wall at a

Figure 14-24  The Bend Position 
slide-down panel 

 
specified distance from the selected attachment edge. 
When you choose the Bend Position tab, a slide-down 
panel will be displayed, as shown in Figure 14-24. 
Different types of offsets in the Type area are discussed 
next. 

Profile on Edge
This option in the Type area is used to add bend geometry while keeping the wall 
profile on the original attachment edge.
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Bend Outside
	 This option in the Type area is used to add bend geometry with the bend line tangent 

to the attachment edge.

Offset from Bend Start					   
	 This option in the Type area is used to measure the offset from the attachment edge 

to the bend start. 

Offset from Bend Apex
This option in the Type area is used to measure the offset from the attachment edge 
to the bend apex. 

Constrained
This option in the Type area is used to keep the attached wall geometry within the 
boundary of the attached edge.

Value  
In the Value edit box, type an offset value or choose a previously used value from the 
list displayed when you place cursor on the down arrow. A positive value will add to the 
attachment segment and a negative value will trim the attachment segment by the specified 
value.

Relief Tab
The reliefs control the sheetmetal material behavior and prevent unwanted deformation. For 
example, consider a bend without a relief. It might not represent an accurate real life model due 
to the stretching of material. By adding the appropriate bend relief, the sheetmetal bend will 
meet your design intent and enable you to create an accurate flat model. Reliefs may be added 
to the model at various stages of its creation.

The Relief tab allows you to choose the type of relief to be

Figure 14-25  The Relief slide-down 
panel

 
applied on the wall. When you choose the Relief tab, a 
slide-down panel will be displayed, as shown in Figure 
14-25, select type of relief from the Relief Category List 
area. When the Define each side separately check box is 
selected, the Side 1 and Side 2 radio buttons will be 
enabled. These options are discussed next. 

Side 1 
	 The Side 1 radio button is used to apply a relief on 

one side of the attachment edge.
	

Side 2 
	 The Side 2 radio button is used to apply a relief on 

the other side of the attachment edge. 

Type Drop-down List 			          
	 The Type drop-down list specifies different types of reliefs such as No Relief, Rip, Stretch, 

Rectangular, and Obround. By default, the Rip is selected in the Type drop-down list. The 
different types of reliefs are discussed next.
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Stretch Relief: This type of relief stretches the material, in which the bent area intersects 
the fixed area. The stretch relief is shown in Figure 14-26.

Rip Relief: This type of relief cuts the material at each bend endpoint. The cuts are made 
normal to the bend line. The rip relief is shown in Figure 14-27.

Figure 14-26  Model with the stretch relief Figure 14-27  Model with the rip relief

Rectangular Relief: This option adds a rectangular relief at each bend endpoint. The 
rectangular relief is shown in Figure 14-28.

Obround Relief: This option adds an obround relief at each bend endpoint. The obround 
relief is shown in Figure 14-29.

Figure 14-28  Model with the rectangular relief Figure 14-29  Model with the obround relief 

	 When you select the Corner Relief option, the Type drop-down panel will be displayed. 
The corner reliefs available in this drop-down are V Notch, No relief, Normal, Circular, 
Square, Rectangular, and Obround.

Bend Allowance Tab			         
The Bend Allowance tab is used to calculate the undeveloped length

Figure 14-30  The Bend 
Allowance slide-down panel

 
of the sheetmetal required to create a bend of specified radius 
and angle. When you choose the Bend Allowance tab, a slide-
down panel will be displayed, as shown in Figure 14-30. By default, 
the Use part settings option is selected in the Developed length 
calculation drop-down list. When you select the Use feature 
settings option from the drop-down list, the By K factor, By Y 
factor, and By bend table options will get enabled. These options 
are discussed next.
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By K factor
K Factor is the ratio between the neutral bend line and thickness of the material.

By Y factor
	 Y Factor is a variable based of the more commonly used K Factor. It is derived by taking half 

of the K Factor multiplied by pi. 

By Bend table	
	 It controls the calculations required for the length of flat material (developed length) needed 

to create a bend.

Adds bend on the attachment edge
The Adds bend on the attachment edge button creates a bend between the existing 
sheetmetal wall and the newly created wall. This button is available on the dashboard. 

There are three methods of specifying the bend parameters of the flat wall and these are discussed 
next.

Dimension the inner surface of the bend
On choosing this button, you can specify the dimension for the inner surface of the 
bend.

	
Dimension the outer surface of the bend

On choosing this button, you can specify the dimension for the outer surface of the 
bend.

By Parameter
When you choose this button, the radius value and the radius side are automatically 
taken from the SMT_DFLT_BEND_RADIUS and SMT_DFLT_RADIUS_SIDE 
parameters.

	
	 Figure 14-31 shows the base wall and Figure 14-32 shows the flat wall created on the rear 

edge of the base wall.

Figure 14-31  Model of the base wall Figure 14-32  Model with the flat wall
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Creating a Twist Wall						                
  Ribbon:  Sheetmetal > Walls > Twist     

A twist wall is a spiraling or coiling section of sheetmetal. The twist wall is formed around 
an axis running through the center of the wall, turning the ends of the wall in opposite 
directions by a relatively small specified angle. You can attach the twist wall to a straight 

edge or an existing planar wall. The twist wall typically serves as a transition between two areas 
of sheetmetal.

Choose the Twist tool from the expanded Walls group in the Sheetmetal tab to invoke the Twist 
dashboard, as shown in Figure 14-33. The options available in this dashboard are discussed next. 

Figure 14-33  The Twist dashboard

On invoking the Twist dashboard box, you will be prompted to select the attachment edge on 
which the twist wall is to be created. Select the attachment 

Figure 14-34  The Placement 
slide-down panel

edge from the drawing area; the preview of the twisted wall 
will be displayed in the drawing area. Also, some of the options 
in the dashboard will get activated and the selected edge is 
displayed in the Placement collector of the Placement 
slide-down panel, as shown in Figure 14-34. 

By default, the Wall width is calculated using offset dimensions from the attachment edge 
option is chosen in the dashboard. As a result, the width of the twisted wall is calculated using 
offset dimensions from the attachment edge. You can choose the Wall width is calculated and 
centered from the twist axis by a width dimension option to create a twisted wall whose width 
is calculated from the twist axis by the specified dimension. 

When you choose the Wall width is calculated and centered from the twist axis by a width 
dimension option, you can change the start width by specifying a value in the Width edit box 
available next to this option. To locate the twist axis on a datum point, click  and select a 
datum point on the attachment edge; the centerline of the twist wall will pass through the datum 
point. The centerline of the twisted wall will be perpendicular to the start edge and coplanar 
with the existing wall.

In the dashboard, the Use end edge for first direction and Use end edge for second direction 
option is selected by default. You can select the Trim or extend in first direction from edge end 
by a specified value and Trim or extend in second direction from edge end by a specified 
value option from the drop-down to specify the extend of the twisted wall in first and second 
direction of attachment edge.

To modify the end width of the twisted wall, choose the Allows end wall width modification 
option and specify the width in the edit box. You can specify the length of the wall in the Wall 
length edit box. This length is calculated from the attachment edge to the end of the twist axis. 
You can specify the angle of rotation for the twist wall using the Angle edit box. 
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Choose the Bend Allowance tab to invoke the slide-down panel, as shown in Figure 14-35. You 
can use the Wall length in an unbent state edit box to specify the length of the twisted wall in 
unbend state.

Figure 14-36 shows the twist wall attached to the base wall.

Figure 14-35  The Bend Allowance 
slide-down panel

Figure 14-36  Model with the twist wall attached 
to the base wall

Creating an Extend Wall
  Ribbon:  Sheetmetal > Editing > Extend     

The extend wall lengthens an existing wall. You can extend the wall from a straight edge 
on an existing wall to a planar surface or to a specified distance. The Extend button is 

located in the Editing group. This button will be activated only when you select any straight 
edge. On choosing this button, the Extend dashboard will be displayed, as shown in Figure 14-37. 
Now, you can enter the value of extension in the Distance to extend edit box. The options in 
the dashboard are discussed next.

Figure 14-37  The Extend dashboard

Extend the wall by value
This option allows you to extend the wall to a specified distance. You can select a default 
value or enter a required value.

Extend the wall to intersect the reference plane
This option allows you to extend the wall to intersect a plane or face. The plane or face 
to be intersected can be an existing default datum plane, the flat face of another 
independent flat wall, or a new datum plane.

Extend the wall up to the reference plane
This option allows you to extend the wall up to a plane. The plane or face upto which a 
wall is to be extended can be an existing default datum plane, the flat face of another 
independent flat wall, or a new datum plane.
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Figure 14-38 shows two independent unattached flat walls, Figure 14-39 shows the extended 
wall created using the Extend the wall to intersect the reference plane button, and Figure 14-40 
shows the extended wall created using the Extend the wall upto the reference plane button.

Figure 14-38  Model with two 
independent unattached flat walls

Figure 14-39  Extended wall created 
using the Extend the wall to intersect 
the reference plane button

Figure 14-40  Extended wall created using the 
Extend the wall upto the reference plane button 

Creating a Flange Wall
  Ribbon:  Sheetmetal > Walls > Flange     

A flange wall is the bent section of a sheetmetal. To create a flange wall, choose 
Model > Shapes > Flange from the Ribbon; the Flange dashboard will be displayed, 
as shown in Figure 14-41. The options in this dashboard are discussed next. 

Figure 14-41  Partial view of the Flange dashboard 

Placement Tab				  
The Placement tab indicates the reference edge

Figure 14-42  The Placement slide-down panel

chosen to create the flange wall. When you 
choose the Placement tab, a slide-down panel 
will be displayed, as shown in Figure 14-42.
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Shape Tab
The Shape tab indicates the profiles and dimensions of the predefined flange wall shapes such 
as I, Arc, S, Open, Flushed, Duck, C, Z, Joggle, or User Defined. The predefined wall profile 
can be selected from the drop-down list in the Flange dashboard. When you choose the Shape 
tab after selecting the predefined wall profile, a slide-down panel will be displayed with three 
buttons, as shown in Figure 14-43. The Sketch button in the slide-down panel can be used to 
draw the sketch for the user-defined profile. The Open button in the slide-down panel can be 
used to import sketch. Choose the Open button from this slide-down panel; the Open dialog 
box will be displayed. Using this dialog box, you can import the required sketch. The Shape 
attachment area determines the height of the wall. There are two radio buttons in this area: 
Height dimension includes thickness and Height dimension does not include thickness. On 
selecting the first radio button, the thickness of the sheetmetal is included while calculating the 
wall height, whereas on selecting the other radio button, the thickness is not included while 
calculating the wall height. The Save as button in the slide-down panel can be used to save the 
sketch so that you can import it later on. 

Figure 14-43  The Shape slide-down panel

Length Tab				            
The Length tab allows you to extend the end faces of

Figure 14-44  The Length slide-down panel

 
the Flange independently. The edit boxes in the 
slide-down panel can be used to specify the distance 
through which the flange wall has to be extended 
in either direction. When you choose the Length 
tab, the slide-down panel will be displayed, as shown 
in Figure 14-44.				 
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Bend Position Tab					  
The options in this tab are used to create a flat wall at a

Figure 14-45  The Bend Position 
slide-down panel 

 
specified distance from the selected attachment edge. 
When you choose the Bend Position tab, a slide-down 
panel will be displayed, as shown in Figure 14-45. 
Different types of offsets in the Type area are discussed 
next. 

Profile on Edge
This option in the Type area is used to add bend geometry while keeping the wall 
profile on the original attachment edge.

Bend Outside
	 This option in the Type area is used to add bend geometry with the bend line tangent 

to the attachment edge.

Offset from Bend Start					   
	 This option in the Type area is used to measure the offset from the attachment edge 

to the bend start. 

Offset from Bend Apex
This option in the Type area is used to measure the offset from the attachment edge 
to the bend apex. 

Constrained
This option in the Type area is used to keep the attached wall geometry within the 
boundary of the attached edge.

Value  
In the Value edit box, type an offset value or choose a previously used value from the 
list displayed when you place cursor on the down arrow. A positive value will add to the 
attachment segment and a negative value will trim the attachment segment by the specified 
value.

Miter Cuts Tab				             
When you choose the Miter Cuts tab, a slide-down panel will be displayed, as shown in 
Figure 14-46. Miter cuts are created to allow bending of two sheetmetal plates created in the 
same plane.

Figure 14-46  The Miter Cuts slide-down panel 
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Relief Tab
The Relief tab allows you to choose the type of relief to be provided to the sheetmetal wall 
to prevent any unwanted deformation. This tab can also be used to create bend reliefs and 
corner reliefs. When you choose the Relief tab, a slide-down panel will be displayed, as shown 
in Figure 14-47. 

When the Define each side separately check box is selected in the Relief slide-down panel, the 
Side 1 and Side 2 radio buttons will be enabled. The bend reliefs available in the slide-down 
panel are Rip, Stretch, Rectangular, and Obround. 

When you select the Corner Relief option, the Relief slide-down panel will be displayed, as 
shown in Figure 14-48. The corner reliefs available in this area are V Notch, Normal, Circular, 
Square, Rectangular, and Obround.

Figure 14-47  The Relief slide-down panel 
with the Bend Relief option selected

Figure 14-48  The Relief slide-down panel with 
the Corner Relief option selected 

Bend Allowance Tab
When you choose the Bend Allowance tab, a slide-down panel will be displayed, as shown in 
Figure 14-49. When the Use feature settings option is selected in the drop-down, the By K 
factor radio button, the By Y factor radio button, and the Use Bend table check box will be 
enabled. These options have already been discussed earlier in this chapter.

Properties Tab				          
When you choose the Properties tab, a slide-down panel will be displayed, as shown in 
Figure 14-50. This slide-down panel displays the feature identity in the Name collector. The 
i button in the slide-down panel, when chosen, opens the browser that displays the information 
about the feature you have created. 



Working with Sheetmetal Components			                                                                                                                             14-21

Figure 14-49  The Bend Allowance 
slide-down panel 

Figure 14-50  The Properties slide-down panel

Figure 14-51 shows a flange wall with a rectangular relief created on the primary unattached 
flat wall.

Figure 14-51  Model with the flange wall attached to the base wall

CREATING THE BEND FEATURE
  Ribbon:  Sheetmetal > Bends > Bend drop-down > Bend     

The Bend tool transforms the sheetmetal wall into an angular or roll shape. You need to 
sketch a bend line and determine the direction of the bend using the direction arrows or 

by orienting the sketching view. The bend line is used as the reference for calculating the 
developed length and creating the bend geometry. Bends can be added at any time during the 
design process as long as a wall feature exists. You can add bends across form features, but you 
cannot add them where they cross another bend. Depending on where you place the bend in 
your sheetmetal design, you may need to add reliefs to the bend. 

To create a bend, choose the Bend tool from the Bend drop-down of the Bends group in the 
Model tab of the Ribbon; the Bend dashboard will be displayed, as shown in Figure 14-52. The 
options in this dashboard are discussed next.
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Figure 14-52  Partial view of the Bend dashboard

Bend material upto bend line 
When you choose this button, the outer edge of the bend will become collinear to the bend 
line. Figure 14-53 shows the bend line and its drag handle and Figure 14-54 shows preview 

of the bend created using the Bend material upto bend line button.

Figure 14-53  Bend line and drag handle of 
the bend line

Figure 14-54  Preview of the bend created using 
the Bend material upto bend line button

Bend material on other side of bend line 
On choosing this button, the sheetmetal component will bend from the bend line, refer 
to Figure 14-55.

Bend material on both sides of bend line 
When you choose this button, the bend material will be added on both sides of the bend 
line, refer to Figure 14-56.

Change location of fixed side 
Using the Change location of fixed side button, you can change the fixed side of the 
bend. Alternatively, you can click on the horizontal arrow displayed in the preview of bend 

to flip the fixed side.

Use value to define the bend angle 
This button is used to create a bend through an angle. The vertical arrow displayed in the 
preview of bend determines the direction of the bend. When you click on the vertical arrow, 

the direction of bend gets reversed. Alternatively, you can choose the Change bending direction 
button next to the angle input edit box in the dashboard.
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Figure 14-55  Preview of the bend created using 
the Bend material on other side of bend line 
button

Figure 14-56  Preview of the bend created using 
the Bend material on both sides of bend line 
button

In the dashboard, there is a drop-down list next to the Change bending direction button. There 
are two options available in this drop-down list to measure the bend angle. These options are 
discussed next.

Measure the resulting internal bend angle
When this option is selected, the bend angle is calculated from the fixed side.

Measure the bend angle deflection from straight
When this option is selected, the bend angle is calculated from the side to be bent.

Bend to end of surface		        
Using this button, you can create a bend upto the end of the surface selected for bending. 
When you choose this button, the angle edit box will become inactive. Now, you need to 

enter the radius value in the edit box next to the Change bending direction button. You can 
use the inner radius or outer radius by using the options in the drop-down list next to the radius 
value edit box. Figure 14-57 shows the preview of the model after choosing the Bend to end of 
surface button and the Bend material on other side of bend line button from the dashboard. 
Therefore, using this tool, you can create a roll of the sheetmetal.

Placement Tab
When you click on the Placement tab, a slide-down panel will be displayed, as shown in 
Figure 14-58. Also, you will be prompted to select a surface or an edge to define the bend 
surface or bend line. On selecting the edge, the preview of the bend will be displayed and the 
Offset bend line check box will become active. After selecting this check box, you can enter the 
distance value of the bend line from the selected edge. 
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Figure 14-57  Preview of the model created using the 
Bend to end of surface and Bend material on other 
side of bend line buttons

Figure 14-58  The Placement 
slide-down panel

Bend Line Tab				                            
This tab is active only after selecting a surface. If you click on the Bend Line tab, a slide-down 
panel will be displayed, as shown in Figure 14-59. To create a bend line, click on the Reference 
collector in the Bend line end 1 area and select the desired edge. Now, you need to select an 
offset reference. Click on the Offset reference collector and select the desired edge as offset 
reference. You can enter the distance value of the offset reference in the edit box adjacent to 
the offset collector, which was selected earlier. In this way, the first end point is defined. Use the 
same procedure to define the second end point of the bend line.

Figure 14-59  The Bend Line slide-down panel

Alternatively, select any of the red handles displayed on the selected surface and drag it to the 
desired edge. Note that when you drag the handle to an edge, the shape of the handle changes 
to the closed square and finally to a yellow circle. When you drop the handle on the edge, a 
new handle connected to the earlier selected handle will be displayed in the screen. Drag this 
new handle to another edge to define the offset reference. Same procedure will be required for 
the other handle.
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Transitions Tab
When you click on the Transitions tab, a slide-down panel is displayed, as shown in Figure 14-60. 
This slide-down panel is used to add a transition area on the sheetmetal. To define the transition 
area, click on the Add Transition option displayed in the slide-down panel; the Transition 1 
option will be added to the transition list and the Sketch button will be activated. You need to 
choose this button and draw two straight lines to define the transition area. Figures 14-61 and 
14-62 show the preview of the bend before and after applying transition, respectively. Rest of 
the tabs are discussed earlier.

Figure 14-60  The Transitions slide-down panel

Figure 14-61  Preview of the bend before applying transition

Figure 14-62  Preview of the bend after applying transition
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Edge Bend
  Ribbon:  Sheetmetal > Bends > Bend drop-down > Edge Bend     

The Edge Bend tool is available in the Bend drop-down of the Bends group in the 
Sheetmetal tab. You can create rounds at the sharp edges by using this tool. When you 

choose this tool, the Edge Bend dashboard will be displayed, as shown in Figure 14-63. Also, 
you will be prompted to select edges. Select the edge on which you want to create a round; the 
preview of the bend will be displayed on the screen.  

Figure 14-63  Partial view of the Edge Bend dashboard

Planar Bend
  Ribbon:  Sheetmetal > Bends > Bend drop-down > Planar Bend     

A Planar bend forces the sheetmetal wall around an axis that is normal to the surface and 
the sketching plane. You need to sketch a bend line and form the planar bend around an 

axis using the direction arrows which will be displayed in the drawing area. Choose the Planar 
Bend tool from the Bend drop-down in the Bends group of the Sheetmetal tab; the OPTIONS 
menu will be displayed. Choose Angle > Done from the OPTIONS menu; the BEND Options: 
Angle, Planar dialog box and the USE TABLE menu will be displayed. Choose the required 
option and then choose Done/Return from the USE TABLE menu. You will next be prompted 
to select the sketching plane. Select the sketching plane and define its orientation. Sketch the 
bend line and specify the direction of the bend through the direction arrows, which appear in 
the drawing area. Figure 14-64 shows the bend line sketched on the base wall and Figure 14-65 
shows a bend created on the base wall using the Planar option. There are two types of Planar 
bends. They are discussed next. 

Figure 14-64  Bend line sketched on the base wall Figure 14-65  Bend created on the base wall

Angle
	 This option, when selected, bends the sheetmetal wall through a specified radius and angle.
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Roll
	 This option, when selected, bends the sheetmetal wall through a specified radius, but the 

angle is determined by both the radius and the amount of flat material to be bent.

Note
You cannot copy a bend using the Mirror option. While you can generally unbend zero-radius 
bends, you cannot unbend the bends with cuts across them. If you do modify the developed length, 
remember that revising the developed length only affects the unbent geometry and not the bend 
back features.

CREATING THE UNBEND FEATURE
  Ribbon:  Sheetmetal > Bends > Unbend drop-down > Unbend     

The Unbend option flattens any curved surface on the sheetmetal part. The curved surface 
may be a bend feature or a primary or secondary wall created previously. When you choose 

the Unbend tool from the Unbend drop-down in the Bends group of the Sheetmetal tab, the 
Unbend dashboard will be displayed, as shown in Figure 14-66. Note that when you invoke this 
dashboard the surface created first gets selected automatically. If you want to change the selection, 
then right-click in the Fixed geometry collector and choose the Remove option from the shortcut 
menu. The different options in the Unbend dashboard are discussed next.

Figure 14-66  Partial view of the Unbend dashboard 

References selected automatically 
The References selected automatically button is chosen by default in the Unbend 
dashboard. So, on applying the Unbend tool, all the bent edges are unbent automatically. 

Note that the section chosen to create the unbend feature must be developable. 

References selected manually
This button is used to select the bend edges manually. You can select more than one edge 
by holding the CTRL key. When you select the bend edges, the preview of unbent model 

will be displayed on the screen. 

Select a surface or an edge to remain fixed during the unbending
This collector is used to collect a surface or an edge to be kept fixed during unbending.

References Tab
When you click on this tab, the References slide-down panel is displayed. In this slide-down 
panel, two collectors are available, Bent Geometry and Fixed Geometry. The Bent Geometry 
collector is used to collect the edges or surfaces to be unbent and the Fixed Geometry collector 
is used to collect the surfaces or edges to be fixed.
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Deformations Tab
When you click on this tab, the Deformations slide-down panel is displayed. Now, you can add 
a surface to the Deformation surfaces collector. The surfaces that deform in more than one 
direction are added to this collector.

Distinct Areas Tab
The options in this tab are used to display and set a fixed geometry reference for one or more 
distinct areas in the part. This area will be activated only when the particular surface is selected 
which is fixed for that distinct area in the Deformation surfaces collector of the Deformations 
tab. The options in this tab are discussed next.

Distinct Piece
This area displays all automatically detected as well as manually selected distinct area 
references.

Fixed geometry
This area displays the surface or edge reference that remains fixed during the unbend 
operation. When you select a non-tangent edge, the Flip button in this area gets activated 
which can be used to flip the side of the edge that remains fixed during the unbend operation.

Deformation Control Tab
When you click on this tab, a slide-down panel is displayed. The options in this panel are used 
to control the type of deformation for the area selected for deformation. There are three radio 
buttons in this panel. These radio buttons are discussed next.

Blend Boundaries
When this radio button is selected, the boundaries of the deformation area are blended 
with the adjacent part edges.

Rip area
When this radio button is selected, the deformation area is removed and a flat pattern is 
created.

Sketch area
When this radio button is selected, the deformation area is created based on the flat 
impression of the sketch created.

Options Tab
You can use options in the Options tab to create the relief geometry during the unbend operation. 
You can also redefine the side surfaces if they have been removed using the options in this tab. 
The options in this tab are discussed next.

Merge colocated side surfaces
This check box is used to toggle the removal of side surfaces that have common location.

Unfold bends added to forms
This check box is used to toggle the unbending/bending of geometry, which is added to a 
form and is not the part of the original form.
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Create relief geometry
This check box is used to toggle the creation of corner relief geometry as set in the relief 
area of the Sheetmetal Preferences dialog box. Note that you can create relief only for 
corners which do not have already specified reliefs.

Figure 14-67 shows a model with a flat wall attached to the primary wall and a bend created at 
either ends. Figure 14-68 shows the unbend model created using the Unbend tool.

Figure 14-67  Model with the bend and 
a flat wall

Figure 14-68  Model after unbending

Creating the Bend Back 
  Ribbon:  Sheetmetal > Bends > Bend Back     

The Bend Back tool is used to revert a bend to the unbent position. Remember that ideally 
you can bend back only the unbent features. When you choose the Bend Back tool from 

the Bends group, the Bend Back dashboard will be displayed, as shown in Figure 14-69. Note 
that when you invoke this dashboard, the surface created first gets selected automatically. To 
change the selection, right-click in the Fixed geometry collector and choose the Remove option 
from the shortcut menu. For manual selection, choose the Manually select unbent geometry 
to bend back button from the dashboard to select the edges or faces to be bent. Click in the 
Fixed geometry collector adjacent to the Manually select unbent geometry to bend back 
button. Then select the surface which you need to make fixed while creating the bend back 
feature. As soon as you select the fixed surface, the preview of bend back feature will be displayed. 
The options in the Bend Back dashboard are discussed next.

Figure 14-69  Partial view of the Bend Back dashboard

References Tab 
There are two collectors available under this tab: Unbent geometry and Fixed geometry. The 
Unbent geometry collector is used to collect the geometries that are to be bent, whereas the 
Fixed geometry collector is used to collect the geometries that are to be fixed. 

Bend Control Tab
This tab is used to control the behavior of contours that intersect with the bend line. There are 
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two radio buttons to control the behavior of contours. You can choose the Bend contour radio 
button to bend the contour or you can make them flat by choosing the Keep flat radio button.

Figure 14-70 shows the model with the surfaces selected for creating the bend back feature and 
Figure 14-71 shows the model created by using the Bend Back tool.

Figure 14-70  Model with the surfaces 
selected for creating the bend back feature

Figure 14-71  Model after creating the 
bend back feature 

Note
The model shown in Figure 14-70 is a base wall, with flange walls attached to its front and rear 
edges. Both the flange walls are unbent, while the base wall is selected as the section to be kept 
fixed. The Bend Back tool is then applied on the model.

CONVERSION TO SHEETMETAL PART
Converting solid parts to sheetmetal parts enables you to modify your existing solid design with 
sheetmetal industry features. The conversion can serve as a shortcut in your design process 
because you can use existing solid designs to reach your sheetmetal design intent. Also, you 
can include multiple features within a single conversion feature. After you convert a part to 
sheetmetal, the part behaves like any other sheetmetal component.

Basic Conversion
The process of converting a solid model into a sheetmetal component by removing one of the 
surfaces or by making one of the surfaces of the solid model as the driving surface is known 
as the basic conversion. To make a basic conversion, choose Convert to Sheetmetal from the 
Operations group of the Model tab in the Ribbon in model environment; the Convert dashboard 
will be displayed with three options in the Select the conversion method dropdown list. These 
option are Convert solid bodies to sheet metal bodies by selecting a driving surface, Convert 
solid bodies to sheet metal bodies by hollowing out the inside of the solid and Convert empty 
solid bodies to empty sheetmetal bodies. The Shell option is used mostly for block-like parts, 
while the Driving Surface option is generally used for thin protrusions with constant thickness.

The basic conversion defines how you want to use the existing solid part in your sheetmetal design. 
You can create the shell feature on the solid model by selecting the surfaces to be removed, or 
you can make any one of the surface of the solid model as a driving surface (the driving side). 
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Figure 14-72 shows the solid model and Figure 14-73 shows the model after shelling and 
removing the bottom face.

Figure 14-72  Model of the solid part Figure 14-73  Model after converting it into sheetmetal 
component by removing the bottom face

Sheetmetal Conversion
  Ribbon:  Sheetmetal > Engineering > Conversion 

If the converted part is not manufacturable, then you need to make a sheetmetal conversion 
by adding features such as rips, bends, and corner reliefs. To do so, choose Conversion 

from the Engineering group in the Sheetmetal environment; the Conversion dashboard will 
be displayed, as shown in Figure 14-74.

Figure 14-74  Partial view of the Conversion dashboard

While converting a solid model into a sheetmetal component, you might need to add certain 
features such as corner reliefs, edge rips, bends, and so on to make the component manufacturable.

The options available in the dashboard are discussed next.

Edge Rip
A rip feature can be defined as a zero volume cut that tears or shears the sheetmetal walls. 
If the sheetmetal component you are designing is a continuous piece of material, you 

cannot unbend the component without creating the rips. This option creates rips along the 
selected edge, which enables you to unbend the sheetmetal part.

Rip Connect
The Rip Connect option connects existing planar rips with straight line rips. The rip 
connects are sketched as point-to-point connections, which require you to define rip 
endpoints. The endpoints can be datum points or vertices and must be the endpoints of 
a rip. 
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Edge Bends
This option converts sharp edges to bends. By default, the inner radius of the bend is set 
to the thickness of the sheetmetal wall. 

Corner Reliefs
This option creates reliefs in selected corners.

Figure 14-75 shows a solid model that has been converted into a sheetmetal component and 
Figure 14-76 shows the model with the edge rip, rip connect, and bend features. 

Figure 14-75  The solid model after being 
converted into a sheetmetal component

Figure 14-76  Model with the edge rip, 
rip connect, and bend features

CREATING CUTS IN THE SHEETMETAL COMPONENT
The process of creating cuts in a sheetmetal component is similar to the one followed to create 
cuts in a solid model. The Extruded Cut tool in the Engineering group of the Sheetmetal tab 
and the Extrude tool in the Shapes group of the Model tab can be used to create cuts in a 
sheetmetal component. 

Extruded Cut
  Ribbon:  Sheetmetal > Engineering > Extruded Cut  

Choose the Extruded Cut tool from the Engineering group to invoke the Extruded Cut 
dashboard, as shown in Figure 14-77.

Figure 14-77  Partial view of the Extruded Cut dashboard 

This option is only activated when you have created a primary wall in your design. The options 
in the Extruded Cut dashboard have the same functionality as the Extrude dashboard discussed 
in earlier chapters. 

The cut features in sheetmetal components are created with reference to the driving surface or 
the offset surface. Driving surface is the surface on which you create the base feature. When you 
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invoke the Extruded Cut dashboard, the Remove material normal to surface button is chosen by 
default. There are three options through which you can create cuts in a sheetmetal component.

Remove material normal to both Driving and Offset surfaces
This button, if chosen, removes material normal to both the driving and offset surfaces. 

Remove material normal to Driving surface
This button, if chosen, removes material normal to the driving surface. This button is 
chosen by default.

Remove material normal to Offset surface
This button, if chosen, removes material normal to the offset surface.

CREATING THE FLAT PATTERN
The Flat Pattern tool is equivalent to the Unbend feature. This feature flattens any curved 
surface, whether it is a bend feature or a wall. But the most distinctive characteristic of the 

Flat Pattern tool is that it automatically places itself at the end of the Model Tree to maintain 
the flat model view. If new features are added to your design, the flat pattern is suppressed but 
is automatically resumed after the features are added. If you do not want to flip between the flat 
pattern and the solid views for each new feature, manually suppress and resume the flat pattern 
as required. You can create a flat pattern at any point in your design because of the property 
that the feature jumps to the end of the Model Tree to maintain the flat model view.

Note
You can create only one flat pattern per part. Once you create a flat pattern, this option is disabled.

To create a flat pattern, choose Sheetmetal > Bends > Flat Pattern from the Ribbon; you are 
prompted to select the edge or plane that will remain fixed during the process of creating the 
feature. Select the surface you want as fixed and the flat pattern of the model is created in the 
drawing area. 

Figure 14-78 shows a sheetmetal component chosen to create the flat pattern. Select the primary 
wall surface that needs to remain fixed. The model after using the Flat Pattern tool is shown 
in Figure 14-79.

Figure 14-78  Model for creating the 
flat pattern

Figure 14-79  Model after creating 
the flat pattern
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Tip
You can choose the Flat Pattern Preview button ( ) from the Graphics toolbar to preview 
the flat sheet. On choosing this button, the Flat Pattern Preview window will be displayed. 
You can also preview the dimensions of the flat pattern by choosing the Bounding Box button 
displayed in the window.

TUTORIALS
Tutorial 1

In this tutorial, you will create the sheetmetal component of the Holder Clip shown in 
Figure 14-80. The flat pattern of the component is shown in Figure 14-81. The dimensions 
are shown in Figure 14-82. The thickness of the sheet is 1 mm. After creating the sheetmetal 
component, create its flat pattern.			                       (Expected time: 45 min)  

Figure 14-80  Model for Tutorial 1 Figure 14-81  The flat pattern of the component

Figure 14-82  Top and front views of the Holder Clip
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	 The following steps are required to complete this tutorial:

a. 	 Create the base feature.
b. 	 Create the flange walls on the right and left edges of the base wall.
c. 	 Create the next flange wall on the front edge of the base wall. Next, create a cut feature on 

it.
d. 	 Create a flat wall attached to the flange wall created in the previous step.
e. 	 Create the next flange wall.
f. 	 Create the next flange on the other front edge of the base wall.
g. 	 Create the round feature and the chamfer feature.
h. 	 Create the hole features on the top and bottom walls.
i. 	 Create the flat pattern of the model.

Starting a New Object File
1.	 Start a new file in the Part mode and select Sheetmetal from the Sub-type area. Next, enter 

c14tut1 in the Name edit box. 

2.	 Set the template to mmns_part_sheetmetal_abs.

Creating the Base Wall
1.	 Choose the Planar tool from the Walls group; the Planar dashboard is displayed and you 

are prompted to select a closed sketch.

2.	 Choose the References tab from the Planar dashboard to display a slide-down panel and 
then choose the Define button from the slide-down panel; the Sketch dialog box is displayed 
and you are prompted to select a sketching plane.

 
3.	 Select the TOP datum plane from the drawing area and then choose the Sketch button 

from the Sketch dialog box.

4.	 Draw the sketch for the base wall, as shown in Figure 14-83, and then choose the OK button 
to exit the sketcher environment.

5.	 Enter 1 in the edit box of the Planar dashboard and choose the OK button from the 
dashboard to complete the creation of the feature. The model similar to the one shown in 
Figure 14-84 is displayed in the drawing area.

Figure 14-83  The sketch for the base wall Figure 14-84  Isometric view of the model
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Creating the First Flange Wall
1.	 Choose the Flange tool from the Walls group; the Flange dashboard is displayed and you 

are prompted to select the edge to attach the wall.

2.	 Select the right edge of the base wall, as shown in Figure 14-85; the preview of the flange 
wall is displayed in the drawing area. The I profile is selected by default in the selection 
box above the Placement tab in the Flange dashboard. The dimension, indicating the bend 
radius at the attachment edge, is also displayed in the drawing area. The default value of 
radius is selected as Thickness, which is dimensioned from the inner surface of the bend.

Figure 14-85  The attachment edge for the flange wall

3.	 Choose the Shape tab from the Flange dashboard to display the slide-down panel and click 
on Section Preview then double-click on the default height value in the slide-down panel. 
Next, enter 41. The angle at which the wall is created with respect to the base wall is selected 
as 90-degree by default. You can also drag the handles and adjust the values dynamically. 
Alternatively, double-click on the values displayed on the model; the edit boxes will be 
displayed where you can enter new values as per your requirement.

4.	 Choose the Dimension the outer surface of the bend button from the Flange dashboard 
and enter 2 in the edit box; the preview of the wall is displayed in the drawing area.

5.	 Choose the OK button from the Flange dashboard to complete the creation of the wall; the 
model similar to the one shown in Figure 14-86 is displayed in the drawing area.

Figure 14-86  Model with the flange wall

Creating the Next Flange Wall
1.	 Select the attachment edge, which is the inner edge of the previously created flange wall, as 

shown in Figure 14-87, and create a flange wall as discussed earlier, with 22 as its height value 
and 2 as its radius value. The model similar to the one shown in Figure 14-88 is displayed 
in the drawing area.
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Figure 14-87  The attachment edge chosen for 
the flange wall

Figure 14-88  Model with the flange wall

Creating the Flange Walls on the Left Edge of the Base Wall
1.	 Create the flange walls on the left edge of the base wall by following the similar procedure 

that you used for creating the flange walls on the right edge. The model after creating the 
flange walls on the left edge of the base wall is shown in Figure 14-89. You can also mirror 
the left side flange walls about the RIGHT plane.

Figure 14-89  Model after creating the flange wall on the left edge

Creating Next Flat Wall on the Front Edge of the Base Wall
1.	 Choose the Flat tool from the Walls group; the Flat dashboard is displayed and you are 

prompted to select the edge to attach the wall.

2.	 Select the front edge of the base wall, as shown in Figure 14-90; the preview of the flat wall 
is displayed in the drawing area.  

3.	 Choose the Shape tab to display the slide-down panel and click on the Sketch option. Draw  
the sketch for the flat feature, as shown in Figure 14-91. 

4. 	 Exit the sketcher environment. The angle at which the wall is created with respect to the 
base wall is selected as 90-degree by default.
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Figure 14-90  The attachment edge for the 
flat wall 

Figure 14-91  The sketch for the flat feature

5.	 Choose the Dimension the outer surface of the bend button from the Flat dashboard and 
enter the value 2 in the edit box. The preview of the flat wall is displayed in the drawing 
area.

6.	 Choose the OK button from the Flat dashboard; the model similar to the one shown in 
Figure 14-92 is displayed in the drawing area.

Figure 14-92  Model after creating the flat feature

Creating the Next Flange Wall
1.	 Choose the Flange tool from the Walls group; the Flange dashboard is displayed and you 

are prompted to select the attachment edge to create the wall.

2.	 Select the attachment edge, as shown in the Figure 14-93; the preview of the flange wall is 
displayed in the drawing area. 

3.	 Choose the Shape tab from the Flange Wall dashboard to display the slide-down panel. 
Specify 30 as the value for the height of the wall in the edit box in the slide-down panel. 
The angle at which the wall is created with respect to the front flange wall is selected as 
90-degree by default.

4.	 Enter 2 as the dimension for creating the bend at the attachment edge which is dimensioned 
from the outer surface of the bend.



Working with Sheetmetal Components			                                                                                                                             14-39

5.	 Choose the OK button from the Flange dashboard to complete the creation of the feature. 
The model similar to the one shown in Figure 14-94 is displayed in the drawing area.

Figure 14-93  The attachment edge 
for the flange wall 

Figure 14-94  Model showing the flange wall

Creating the Next Flange Wall on the Front Edge of the Base Wall
1.	 Create the next flange wall on the front edge of the base wall by selecting the attachment 

edge, as shown in Figure 14-95, and specifying the height of the wall as 19. The model 
similar to the one shown in Figure 14-96 is displayed in the drawing area.

Figure 14-95  The attachment edge for the 
flange wall

Figure 14-96  Model showing the flange 
wall on the front edge of the base wall

Creating the Round and Chamfer Features
1.	 Create the rounds with radius 7, as shown in Figure 14-97, using the Round tool available 

in the Engineering group.

2.	 Create the edge chamfer, as shown in Figure 14-98, using the Edge Chamfer tool available 
in the Engineering group. For dimensions of the edge chamfer, refer to Figure 14-82. 
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Figure 14-97  Model after creating 
the round feature

Figure 14-98  Model after creating the 
chamfer feature

Creating the Hole Features on the Top and Bottom Walls
1.	 Choose the Hole tool from the Engineering group of the Ribbon; the Hole dashboard is 

displayed.

2.	 Select the top surface of the base wall and specify the placement parameters for the 
hole having diameter 13, refer to Figure 14-82.

3.	 Choose the OK button from the Hole dashboard to exit it. The model after creating the 
hole feature on the top surface of the base wall is shown in Figure 14-99. 

4.	 Similarly, create the hole feature on the bottom flange wall by specifying the placement 
parameters, refer to Figure 14-82. The model after creating the hole feature on the bottom 
flange wall is shown in Figure 14-100.

Figure 14-99  Model with the hole 
feature on the base wall 

Figure 14-100  Model with the hole 
feature on the bottom flange wall

Creating the Flat Pattern of the Model
1.	 Choose the Flat Pattern button from the Bends group; the flat pattern of the model is 

created with the 3D notes.

2.	 To clear the 3D notes, choose Annotation Display Filter > Annotation Display from the 
Graphics toolbar. The flat pattern of the model is displayed, as shown in Figure 14-101.
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Figure 14-101  Model after creating the flat pattern

Saving the Model
1.	 Choose the Save button from the Quick Access toolbar to save the model.

Tutorial 2
In this tutorial, you will create the sheetmetal component shown in Figure 14-102. The flat pattern 
of the component is shown in Figure 14-103. The dimensions are shown in Figure 14-104. The 
thickness of the sheet is 1 mm, Bend Radius is 1 mm, Relief Type is Rectangular, and width 
value is equal to thickness. After creating the sheetmetal component, create its flat pattern.          	
                              	                                                                           (Expected time: 45 min)

Figure 14-102  Model for Tutorial 2 Figure 14-103  Top view of the model
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Figure 14-104  Orthographic views of the model

	 The following steps are required to complete this tutorial:

a.	 Create the base feature.
b.	 Create the hole feature on the top surface of the base wall.
c.	 Create a flange wall on the right edge of the base wall.
d.	 Create the cut feature.
e.	 Create the next flange wall attached to the wall created previously.
f.	 Create the two flange walls along with the cut feature on the left side of the base wall as 

created previously.
g.	 Create the flat wall on the front edge of the base wall.
h.	 Create the flat pattern of the component.

	 If required, set the working directory to C:\Creo-7.0\c14.

Starting a New Object File
1.	 Start a new file in the Sheetmetal mode and name it as c14tut2.

2.	 Set the template to mmns_part_sheetmetal_abs.
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Creating the Base Wall
1.	 Choose the Planar tool from the Walls group; the Planar dashboard is displayed and you 

are prompted to select a closed sketch.

2.	 Choose the References tab from the Planar dashboard to display the slide-down panel. 
Choose the Define button from the slide-down panel; the Sketch dialog box is displayed 
and you are prompted to select a sketching plane. 

3.	 Select the TOP datum plane from the drawing area and choose the Sketch button from the 
Sketch dialog box.

4.	 Draw the sketch for the base wall, as shown in Figure 14-105, and choose the OK button to 
exit the sketcher environment.

5.	 Enter the value 1 in the edit box in the Planar dashboard and choose the OK button from 
the dashboard to complete the creation of the feature. The model similar to the one shown 
in Figure 14-106 is displayed in the drawing area.

Figure 14-105  The sketch for the base wall Figure 14-106  Model of the base wall

Creating the Hole Feature
1.	 Create a hole on the lower right corner of the base wall, as shown in Figure 14-107, by 

specifying the dimensions shown in Figure 14-104.

Creating the Pattern of the Hole Feature
1.	 Create the rectangular pattern of the hole, as shown in Figure 14-108.

Figure 14-107  Model after creating 
the hole feature

Figure 14-108  Model after creating 
the pattern of the hole feature

Creating the First Flange Wall
1.	 Choose the Flange tool from the Walls group; the Flange dashboard is displayed and you 

are prompted to select the edge to attach the wall.
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2.	 Select the right edge of the base wall; preview of the flange wall is displayed in the drawing 
area. 

3.	 Choose the Shape tab from the Flange dashboard to display the slide-down panel and click 
on Section Preview then specify 50 as the value for the height of the wall in the edit box. 

				  
4.	 Choose the Dimension the outer surface of the bend 

Figure 14-109  Model with the flange wall

button from the Flange dashboard and enter 2 as 
the value in the edit box; the preview of the wall 
is displayed in the drawing area.

5.	 Choose the OK button from the Flange dashboard 
to complete the creation of the wall. Figure 14-109 
shows the model after creating the flange wall.

Creating the Extruded Cut Feature
1.	 Choose the Extruded Cut tool from the Engineering group and select the front face of the 

flange wall as the sketching plane.
 
2.	 Draw the sketch for the cut feature on the front face of the previous flange wall, as shown 

in Figure 14-110.

3.	 Extrude the sketch through all faces of the model to create the cut feature, as shown in 
Figure 14-111.

Figure 14-110  The sketch for the Extruded 
Cut feature

Figure 14-111  Model with the Extruded 
cut feature

Creating the Next Flange Wall
1.	 Choose the Flange tool from the Walls group; the Flange dashboard is displayed and you 

are prompted to select the edge to attach the wall.

2.	 Select the attachment edge, as shown in Figure 14-112; the preview of the flange wall is 
displayed in the drawing area.
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3.	 Select the Open option from the Wall profile drop-down list in the dashboard; the preview 
of the wall is displayed in the drawing area.

4.	 Accept the default parameters in the Shape slide-down panel and choose the OK button 
from the Flange dashboard to complete the creation of the wall. 

	 Figure 14-113 shows the model with the flange wall.

Figure 14-112  The attachment edge for the 
flange wall 

Figure 14-113  Model with the flange 
wall

Creating the Flange Walls on the Left Edge of the Base Wall
1.  	 Create the flange walls on the left edge of the base wall by following the same procedure 

that was used for creating the first two flange walls on the right edge of the base wall, refer 
to Figure 14-114. You can also mirror the flange walls with respect to the RIGHT plane.

Creating the Cut Feature on the Left Flange Wall
1.  	 Create the cut feature on the left flange wall by following the procedure used for creating the 

cut on the right flange wall. The model after creating the cut feature is shown in Figure 14-114.

Figure 14-114  Model after creating the flange walls on the left 
edge of the base wall and the cut feature on the left flange wall 

Creating the Flat Wall
1.	 Choose the Flat tool from the Walls group; the Flat dashboard is displayed and you are 

prompted to select the attachment edge to create the wall.
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2.	 Select the front edge of the base wall; the Rectangle profile of 

Figure 14-115  The sketch for the 
flat wall

the wall is chosen by default and the preview of the wall is 
displayed in the drawing area.

3.	 Choose the Rectangle option from the dashboard; a flyout 
is displayed. Choose the User Defined option from the 
flyout.

4.	 Choose the Shape tab from the Flat dashboard to display 
the slide-down panel and click on Section Preview. Choose 
the Sketch button from the slide-down panel; the Sketch 
dialog box is displayed.

5.	 Orient the model such that the top face of the base wall 
is at the top and draw the sketch for the user-defined flat 
wall, as shown in Figure 14-115. Note that the sketch drawn 
should be open at the top. Choose the OK button to exit 
the sketcher environment.

6.	 Choose the Relief tab from the Flat dashboard to display the slide-down panel and then 
select the Rectangular option from the Type drop-down list. Accept the default parameters 
for the relief. You may need to choose the Flip button to flip the direction.

7.	 Choose the OK button from the Flat dashboard to complete the creation of the flat wall. 

8.	 Create a bend feature on the flat wall, refer to Figure 14-104. The model similar to the one 
shown in Figure 14-116 is displayed in the drawing area.

Creating the Flat Pattern of the Model
1.	 Choose the Flat Pattern tool from the Bends group; the flat pattern of the model is created 

and the model similar to the one shown in Figure 14-117 is displayed in the drawing area.

Figure 14-116  Model after creating the flat wall Figure 14-117  Model after creating the flat 
pattern

Saving the Model
1.	 Choose the Save button from the Quick Access toolbar to save the model.
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Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1. 	 __________, __________, and __________ are three different types of unattached blend walls.

2.	 The __________ in a sheetmetal component control the material behavior and prevent the 
unwanted deformation.

3.  	 In the Sheetmetal environment of Creo Parametric, the __________ wall can be a primary 
or a secondary wall.

4.  	 The __________ tool can be used to lengthen an existing wall.

5.   	The __________ is a reference point for calculating the developed length and creating 	
the bend geometry.

6.  	 The __________ option flattens any curved surface whether it is a bend feature or a curved 
wall.   

  
7.   A __________ feature can be defined as a zero-volume cut.

8.   	In the Sheetmetal design of Creo Parametric, the walls can be categorized into two types. 
(T/F)

9. 	 Flat walls are a type of unattached walls in the Sheetmetal environment of Creo Parametric. 
(T/F)

10. The rotational blend walls have sections that can be rotated about the Y-axis upto a maximum 
angle of 90 degrees. (T/F)

Review Questions
Answer the following questions:

1.	 While creating an unattached blend wall, the __________ option is used to connect vertices 
of all sections in the blend feature with straight lines.

2.	 Parallel blends have sections that are drawn__________ to each other.

3.	 While creating a flange wall, the __________ tab is used to specify the dimensions of the 
predefined wall profiles.

4.	 The __________ feature bends back only unbent features.

5.	 The __________feature is defined as a zero volume cut that tears or shears the sheetmetal 
walls.
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6.	 To convert a solid model into a sheetmetal component, you first need to __________ the 
solid model. 

7.	 If the rotational blend angle between two sections is equal to 0-degree, then the rotational 
blend option functions in the same way as the parallel blend option. (T/F)

8.	 The bend feature can be created on the area that was previously bent. (T/F)

9.	 The flat pattern can be created only once on a sheetmetal component. (T/F)

10.	 The Extruded Cut tool is used to create a cut on a sheetmetal component. (T/F)

EXERCISES
Exercise 1

Create the sheetmetal component shown in Figure 14-118. The flat pattern of the component 
is shown in Figure 14-119. The dimensions of the model are shown in Figure 14-120. 	     	
	  							             (Expected time: 30 min)

Figure 14-118  Model for Exercise 1 Figure 14-119  Flat pattern of the component
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Figure 14-120  Orthographic view of the component

Exercise 2
In this exercise, you will create the sheetmetal component shown in Figure 14-121. The flat 
pattern of the component is shown in Figure 14-122. The dimensions of the model are shown 
in Figure 14-123.		      		                                  (Expected time: 30 min)

Figure 14-121  Sheetmetal part for Exercise Figure 14-122  Flat pattern of the part
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Figure 14-123  Dimensions of the sheetmetal part

Answers to Self-Evaluation Test
1. Parallel, Rotational, General, 2. reliefs, 3. flat, 4. Extend, 5. bend line, 6. Flat Pattern, 7. Rip, 
8. T, 9. T, 10. F


